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This technical note shows how HighRoad can be used for retarding basin design. It includes the design of the 
basin wall, estimation of water volume and preparation of the longitudinal section for the outlet pipe.

Introduction

To follow this example you will need the project fil es included with this tech note.  If you did not receive the 
project fil es with the tech note, you can download them from the Support section of the Creative Engineering 
website at www.createng.com.au

The fil es included are:
 Folder: Files for Tech Note 8
 File: Retarding Basin Site
 File: Retarding Basin Design
 File: Retarding Basin + Pipe

The site

The diagram in Figure 1 over shows part of a subdivision where a retarding basin is required. The area 
marked by the thick shaded line is the area available for the retarding basin. This area currently flo ws into a 
defin ed gully (marked as Outlet to downstream works) on the downstream side of the road.

To view this on your Macintosh, double-click on the fil e Retarding Basin Site. HighRoad will start-up and open 
this project. The Plan window will be active. Choose Fit to Window from the View menu. In the Plan menu, 
choose Show contours and Show features, if they are not already shown. You should see a similar view of 
the site to that shown in the diagram in Figure 1. Take some time to familiarise yourself with the site. In 
particular, identify the features that are highlighted in Figure 1.

The area is to be dammed with an earth wall with a 2m wide top and 3 to 1 side slopes. Preliminary design of 
drainage works has indicated that a storage volume of 5000 m3 is required from this basin. Therefore the 
basin wall should be designed so that at least 5000m3 of water can be stored.

Note: You can zoom in on any feature that you wish to examine more closely. Hold down the command key. 
The cursor should become a magnifying glass with a plus sign. Click the mouse at the point of interest. The 
Plan view will be magnifie d by a factor of two. To shrink the view, hold down the Shift key as well as the 
Command key and the cursor will become a magnifying glass with a minus sign .

Figure 1



Basin wall design

For the first  trial assume that a suitable top water level in this basin comes up to the heavy contour which is 
12.5 metres. The first  task is to lay out the centreline of the basin wall. This is easy to do by following the 
property boundaries and road boundaries shown and keeping in mind the existing surface contours. Begin by 
creating a new control line called Basin Wall and position the IP's (six in all) as shown in Figure 2. Start at the 
bottom near the 12.5 metre contour and work around to the right and up and then fin ish at the top left. Your 
screen should look similar to Figure 2.

To maximise the volume contained, use smaller radii on the bends in the wall. To do this double-click on the 
second IP and change the radius to 10 metres. Use the Next button to move to each of the other bends and 
change the radius of each of these to 10 metres. The control line should now appear as shown in Figure 3.

The next step is to design a typical section for the wall. Go to the Typical Section window, set the scale to 
1:50 and draw a link 1 metre long with zero slope either side of the control line. Next add a split point and 
batter slope down at 33% on each side.  Set the chainage range from 0 to 200 metres.  Your screen should 
now be similar to Figure 4.

Figure 2
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Figure 4

Now design a profil e for the top of the basin wall. The basin will require an overflo w zone for flo ws which 
exceed the capacity of the basin. Such flo ws should be directed onto the road. Since a Top Water Level 
(T.W.L.) of 12.5 metres has been set for the first  trial, you should set the top of the wall at 12.75 metres 
allowing a 250mm freeboard above T.W.L. The overflo w section should be set at the T.W.L. of 12.5.

Go to the the Profil e window and draw a design profil e similar to that shown in Figure 5. The overflo w section 
has been placed between chainage 40 and 60 which would allow the surcharge to run onto the road. Now 
that HighRoad can show the extent of batter slopes, the next step is to review the location of the wall in the 
Plan view. Go to the Plan window and choose Show Basin Wall Details from the Plan menu. Choose Show 
All, transparent road, and display regular chainages and click OK.

Your screen should now look similar to Figure 6. The location of the control line needs some adjustment – the 
batter slopes from the basin wall encroach on the property boundary to the south (bottom of screen) and also 
encroach on the road and the property boundary to the east.

Figure 6

Your Plan view may look slightly different to this because the locations of the IPs have been positioned by you 
in an approximate manner. The objective is to adjust the position of the basin wall so that it does not encroach 
on the adjacent properties or the road. Adjust the IPs if necessary so that no encroachment occurs. At this 
stage high precision is not required because the wall may have to be raised or lowered once an estimate of 
the water volume the basin will hold is made.

Figure 5



The plan will be redrawn after each change that you make. To speed up redraws you can turn off the full 
display of the road. To do this choose Access Road from the Active menu. This will make the Access Road the 
active control line. You can now select Show Access Road Details from the Plan menu and change the 
display to Control line only. Choose Basin Wall from the Active menu to select the Basin Wall as the active 
control line.

This would be a good time to save the changes made so far. Rather than save the changes to this fil e, save 
this work under a new name. Choose Save As... from the File menu and name the fil e Retarding Basin in 
progress.

Figure 7 shows how the plan should look after changing the location of some IPs and also turning off display 
of the Access Road.

Estimating water volume

There are a number of ways of estimating the water volume. In this example the method used will involve 
constructing the wall, then adding another control line to represent the stored water and calculating its 
volume. This is a trial and error method of producing the correct water volume. The design cycle includes six 
steps as follows:

1. Create control line for measuring stored water volume.
2. Adjust the stored water profil e to match T.W.L.
3. Use the Save As... command to save (under a new name) a copy of the fil e Retarding Basin in Progress so 
that it is not amended.
4. Construct the basin wall.
5. Measure the volume.
6. If the volume is not correct, open the fil e Retarding Basin in Progress, adjust the basin wall and repeat from 
step 2 again.

First create a control line to represent the stored water. (This control line will be designed so that the fil l 
volume is equivalent to the volume of stored water.) Name this new control line Stored Water. The control line 
will be positioned along the approximate centre line of the water storage. Position the control line to 
approximate the centre of the water body as shown in Figure 8 below. Place the first  IP on the eastern wall of 
the basin and the last one near the end of the wall past the 12.5 metre contour (the heavy contour) at the top 
left of the basin. (The contour interval is 0.5.)

Figure 7



Draw a typical section for the water body. The typical section is simply a short horizontal link each side of 
centre, a split point at the end of each of these, and a batter link of slope 0% for each side. Set the chainage 
range to 0 to 200. Next design a longitudinal profil e for the top of the water. This is simply two IPs – one 
before the start and one past the fin ish of the natural surface. Both IPs are at TWL which is elevation 12.5.

Calculating volume

Before you can estimate the volume of water that the basin will hold you need be able work with the terrain 
model as though the basin wall has been constructed. Save the project now (this will save the stored water 
control line). Now use the Save As... command to create a new document named Volume trial. Go to the Plan 
window.

Select Basin Wall from the Active menu so that the basin wall is the current control line. The next step is to 
construct the basin wall so that it becomes part of the terrain model. When you use the construct command, 
new terrain points will be created at the cross section interval which is set at 20 metres as the default 
distance. This distance is too short to produce enough cross sections around the bends in the basin wall. For 
this project, five  metres would be a more suitable distance. To set the cross section distance to five  metres, 
go to the Cross Section Plot window and choose Layout from the Section menu. Set the cross section interval 
to five  metres. Go to the Plan window.

Figure 8
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Choose Construct Basin Wall from the Plan menu to construct the basin wall. A dialog box that warns you to 
save a copy before proceeding will appear. Click Continue in the dialog box as you have already saved a 
copy of the fil e. The basin wall will now be constructed. This will take a couple of minutes on the slowest 
Macintosh, and a matter of seconds on the fastest Macintosh. After the new points have been added and the 
triangulation has been redone, the contours are not automatically recalculated and redrawn. You must choose 
Contours... from the Plan menu (and click OK) for the contours to be redrawn correctly. Your screen should 
look like Figure 9.

Now you can calculate the stored water quantities to see how 
close it is to the required volume. First switch to the Stored 
Water control line by selecting it from the Active menu. At this 
point it is important to check that the cross section width is 
suffici ently wide to cover the required width across the basin. 
Choose Cross Section Plot from the Window menu and use the 
Next button to display cross sections along the length of the 
Stored Water control line. The default half width is 20 metres 
and if you haven't changed this you should see the cross section 

at Chainage 30 similar to that shown in Figure 10 below. The longer line is the natural surface. The small line 
above it is the fin ished surface (i.e. the surface of the stored water). The batter slopes have not been able to 
intersect the natural surface, therefore the rest of the fin ished surface cannot be drawn.

Choose Layout from the Section menu and set the natural surface width to 45 metres. This should be enough 
to show the basin walls on each side as shown in Figure 11 below. These cross sections are used for quantity 
calculations so it is important to make sure they are suffici ently wide.

Go to the Quantities window and set the quantities limits to cover the full length of the job (about 100 to 110 
metres). This trial yields about 2300 m3 of fil l, which is less than what is needed. The fil l in this example is 
water. (The value you get will not be exactly the same as this because you may have located the wall 
alignment differently). Close the Quantities window. To get closer to the correct volume, it will be necessary to 
raise the level of the basin wall. For the next trial try a T.W.L. 0.5m higher (i.e. 13m).

Redesigning the basin

Open the Basin in Progress fil e again. (Don't bother to save changes to the Volume trial fil e). Choose Plan 
from the Window menu. The first  task is to extend the basin walls so that they extend past the 13.0 metre 
contour line. Do this by adding a new horizontal IP between IP 1 and 2. Move the first  IP down to the left 
along the contour lines, between the 13 and 13.5 metre contour lines (as shown in Figure 12 below).

Note: In Figure 12 the major contour interval has been changed to 1 metre to make it easier to locate the 
correct contour lines. Choose Contours... from the Plan menu and set the major interval to 1 metre.

Figure 11

Figure 12
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Add another IP to the end of the wall and drag it down to the left, between the 13 and 13.5 metre contour lines 
as shown in Figure 12. Now adjust the design profil e so that the top of wall is 13.25 metres and the overflo w 
weir is 13.0 metres.

Check to see that the basin wall does not run off the edge of the terrain model – if it does, adjust the 
alignment so that is entirely within the terrain model. A control line cannot be constructed if it runs off the edge 
of the model. Now check that the cross section interval is still set to 5 metres and the natural surface width is 
45 metres. These settings will be required when the basin wall is constructed. Save this fil e.

Now it is necessary to do another volume check. Follow the steps for the previous trial, that is:
2. Adjust the stored water control line so that it is long enough (that is it extends to 13.0 metre contour) and 
the stored water profil e to match T.W.L. (13.0 metres)
3. Use the Save As... command to save a copy of the Retarding Basin in Progress fil e so that it is not 
amended. Name the fil e Volume trial (this will replace the old fil e of this name).
4. Construct the basin wall.
5. Measure the volume.

This time the volume should be about 3900 m3. This is still short of the required 5000 m3. The extra volume 
needed is about 1100m3.

Try increasing the height by 0.5 to get close to the required volume. Follow the steps as described in 
Redesigning the basin to complete another trial. Extend the basin walls so that they reach the 13.75m contour 
line. Do this by moving the first  and last horizontal IP's. Raise the height of the wall to 13.75m and the 
overflo w to 13.5 m. The plan should now look as shown in Figure 13 over.

Note: In Figure 13 the cross section interval has been changed to 10 metres to make it easier to show the 
chainages in a less cluttered manner.

Figure 13

The length of the wall has increased substantially so the position of the overflo w has to be adjusted to lie 
between chainage 85 and 105. Figure 14 shows the new wall profil e for a T.W.L. of 13.5 and the overflo w 
moved to the correct location.

Figure 14



The volume should now be about 4700m3 which is almost suffici ent for this project. The T.W.L. has to be 
raised slightly so that the basin holds the required volume. By using a little creative engineering, you can 
make a quick estimate of how much extra volume would be created by raising the water level by 0.1m. 
Calculate the volume with a stripping depth of 100mm. The stripping area is the surface area of the 
construction (which in this case represents the surface of the water). Choose Schedule of quantities from the 
Windows menu. Choose Strip depth and set it to 100mm. Click OK. HighRoad will calculate the additional 
volume equivalent to raising the height of the wall by 0.1m. The new fil l volume with 100mm stripping is 
5140m3 which would be suffici ent. Raise the wall height to 13.85m and the height of the overflo w to 13.6m. 
Construct the basin wall and measure the volume. The result should be about 5200m3 which is suffici ent for 
this project. Save this as Basin in progress.

Profile for outlet pipe

The outlet pipe should run from the low point in the basin, under the road to the outlet location. The first  task 
is to construct the road so that the road will appear on the fin ished surface on the pipe long section. Choose 
construct Access Road from the Plan menu and set the minor contour interval to 0.250m. Now create a 
control line for the pipe. Choose New control line from the Plan menu and name it Outlet pipe. Place the first  
IP in the low point of the basin and the second IP in the low point of the discharge gully. The plan should now 
look as shown in Figure 15.

Figure 15

Choose Profil e from the Windows menu. Add a design gradeline for the pipe invert (see Figure 16).

There is insuffici ent clearance under the road gutter. Add another IP, adjust the positions of the IPs, and set 
the length of the vertical curve at the 2nd IP to zero (because it is usual to have only straight pipe sections on 
a drainage line) as in Figure 17. A pit will need to be placed at the location of IP#2.

Figure 16



Create a typical section for the pipeline. The section will represent the pipe trench so add a horizontal link 
0.6m wide each side of the control line. Then add a split point each side as shown in Figure 18. Do not add a 
batter link - where there is no batter link for quantities calculation, a vertical wall will be inserted.

Figure 18

Display a cross section at the low clearance point (around 22m) as shown in Figure 19. The depth at this 
section is approximately 1m which would be adequate for a 600mm pipe. This clearance is available when the 
grade from IP2 to IP3 is 1% and IP3 is positioned at the natural surface level at the end of the line.

You can also calculate the excavation volume for the trench by choosing Schedule of quantities from the 
Windows menu and setting the limits to the length of this control line. The volume should be around 75m3.

Conclusion

This example has shown how HighRoad can be used for the design and estimation for various types of civil 
engineering works. At this point you could produce a detailed plan of the proposed drainage basin and a 
longitudinal section on the outlet pipe. You could also produce quantities of earthworks for wall construction, 
trench excavation and stored water volume and coordinates for setting out batter pegs for the construction of 
the wall.

Figure 17
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